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Pour votre sécurité Lisez attentivement ce manuel afin d'utiliser cet appareil 
correctement et d'éviter tout danger ou dommage matériel.

Vous risquez de vous blesser gravement si vous ne tenez pas compte de
ces instructions.WARNING

Utilisation de l'appareil

Une mauvaise utilisation peut provoquer des explosions,
des incendies ou des décharges électriques.

Ne prenez pas l'initiative de
démonter, réparer ou 
modifier cet appareil 
vous-même.

Ne mouillez pas l'appareil et
ne le laissez pas tomber dans
l'eau.
Si l'appareil est mouillé, ne 
l'allumez pas. Contactez un centre
de dépannage.

Ne posez pas l'appareil dans
un endroit humide, 
poussiéreux ou couvert de
suie, sous peine de 
provoquer un incendie ou une
décharge électrique.

Ne laissez pas l'appareil dans
un lieu où la température
excède 35°C (comme un
sauna ou une voiture en 
stationnement par exemple).
En été, la température à l’intérieur
d'une voiture peut atteindre 80°C.

Pour éviter les troubles auditifs

L'utilisation prolongée de l'écouteur ou du casque
peut fortement réduire votre acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB
pendant une durée prolongée, votre ouïe sera 
irrémédiablement endommagée. Plus le son est élevé, plus
votre acuité auditive diminue (une conversation ordinaire a un
niveau sonore compris entre 50 et 60 dB alors que celui
provenant d’une route est d'environ 80 dB).
Il est fortement recommandé d'utiliser un volume sonore
moyen (le volume moyen est habituellement inférieur de 2/3
au volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus 
l'écouteur ou le casque.

Pour éviter tout risque d'accident de la route

N'utilisez pas l'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.
Dans le cas contraire, vous risqueriez de provoquer un accident
grave. En outre, son utilisation est interdite par la loi dans 
certaines régions. L'utilisation de l'écouteur dans la rue, 
particulièrement sur les passages pour piétons, pourrait 
entraîner des accidents graves.

Pour votre propre sécurité, assurez-vous que le câble de
l'écouteur n’entrave pas vos mouvements ou ne 
s’accroche pas dans des objets environnants lorsque
vous faites de l'exercice ou lorsque vous vous promenez.

AVERTISSEMENT
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Evitez de causer des dysfonctionnements

Empêchez que des particules
externes ou de la poussière
ne pénètrent dans l'appareil.

Evitez tout impact brutal
sur l'appareil (ex. : en cas
de chute). Ne posez pas
d'objets lourds sur le
dessus de l'appareil.

Evitez toute projection d’eau sur
l'appareil. Ne nettoyez jamais 
l'appareil à l'aide de produits 
chimiques (ex. : benzène ou 
diluant) sous peine de provoquer
un incendie, une décharge 
électrique ou une détérioration de
la surface.

Ne posez jamais l'appareil à
proximité d'objets émettant
des ondes électromagnétiques
sous peine de provoquer un
dysfonctionnement.

Utilisation de l'appareil

Utilisez votre appareil de façon à éviter
tout dysfonctionnement ou tout accident.

Lorsque vous portez 
l'appareil autour du cou,
n’exercez pas de 
pression excessive sur 
la cordelette.

Gestion des données importantes

Veillez à toujours enregistrer vos
données les plus importantes.
Notez bien que nous ne saurons
être tenus responsables en cas de
perte des données due à une
panne, à une réparation ou à toute
autre cause.

Suivez attentivement ces instructions sous peine de provoquer des blessures
physiques ou d'endommager l'appareil. CAUTIONATTENTION
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C
hapitre 1. Préparation

V
érification de l’appareil et des accessoires

Lecteur Ecouteurs Câble USB CD d'installation Attache de ceinture

■ L’aspect des accessoires est susceptible d'être amélioré et modifié sans notification préalable.

Vérification de l’appareil et des accessoires

Vérification des accessoires
Les schémas suivants sont destinés à vous
guider et peuvent légèrement différer de 
l'appareil lui-même.
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Vérification de l’appareil et des accessoires

Composants

Ecran d’affichage

Bouton de changement de plages/ 
recherche rapide

Bouton USER/MENU

Bouton d'alimentation et de lecture/pause

Face avant, côté droit et dessus de l’appareil

Port de connexion des écouteurs
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C
hapitre 1. Préparation

V
érification de l’appareil et des accessoires

Bouton de réglage du volume

Face arrière

Interrupteur Hold

Trou de réinitialisation

Fiche USB

Branchement des écouteurs

√ Haut

Ecouteurs
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Vérification de l’appareil et des accessoires

Affichage des informations à l'écran

Musique

1 Témoin de lecture/pause/arrêt

2 Témoin Numéro de la plage en cours/
nombre de plages total

7 Barre d'état de la lecture

4 Témoin du mode Play (Lecture)

3 Témoin du mode Sound (Son)

5 Témoin de l’état de la batterie

8 Témoin du temps de lecture

6 Témoin du titre de la plage en cours
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C
hapitre 1. Préparation

V
érification de l’appareil et des accessoires

Vérification de l’appareil et des accessoires

Fonctions des boutons

Boutons Fonctions et utilisation

■   Appuyez longuement sur le bouton pour allumer ou éteindre l'appareil.
■   Appuyez brièvement sur le bouton pour sélectionner Lecture/Pause.

HOLD

■   Appuyez longuement sur le bouton pour accéder à l'écran de menu.
■   Appuyez brièvement sur le bouton pour utiliser les fonctions de réglage USER – Navigation/  Repeat 

AB (Répétition AB)/DNSe (Egaliseur)/Play Speed (Vitesse de lecture)/Play Mode (Mode de lecture)

HOLD

■   Appuyez longuement sur le bouton effectuer un balayage rapide des plages.
■   Appuyez brièvement sur le bouton pour sélectionner la plage précédente ou lire

la plage en cours à partir du début.

HOLD

■   Appuyez longuement sur le bouton effectuer un balayage rapide des plages.
■   Appuyez brièvement sur le bouton pour passer à la plage suivante.

HOLD

■  Poussez l’interrupteur dans le sens de la flèche pour verrouiller 
les fonctions des boutons.HOLD

■   Appuyez sur le bouton à l'aide d'un objet pointu pour réinitialiser
le système.

HOLD

■   Appuyez brièvement sur le bouton pour augmenter le volume ou 
pour accéder à l'élément / au menu supérieur.

HOLD

■   Appuyez brièvement sur le bouton pour diminuer le volume ou 
pour accéder à l'élément / au menu inférieur.

HOLD
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Chargement de la batterie Chargez la batterie complètement avant d'utiliser le
lecteur pour la première fois ou lorsqu'il n'a pas été
utilisé depuis longtemps.

Affichage à l’écran

■ Chargement en cours...

■ Chargement terminé

Utilisation de la batterie

■  Rechargez et rangez l'appareil dans un lieu où la température est comprise entre 5 et 35°C.

■  Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger la batterie à des fréquences trop
rapprochées peut réduire sa durée de vie.

■  Comme pour tout autre produit de consommation, la durée de vie de la batterie raccourcit progressivement avec le temps.

■  La connexion USB peut s’avérer instable si vous utilisez un concentrateur USB. Reliez directement la batterie au
port USB de votre ordinateur.

1 Otez le capuchon USB situé sous le corps de l'appareil.

2

2

Branchez le câble USB sur le port USB (      ) de votre ordinateur.

3

3

Branchez l'autre extrémité du câble USB sur le fiche USB situé dans la partie
inférieure du lecteur.
■ Le temps nécessaire à un chargement complet est d'environ deux heures et demie ; il peut 

néanmoins varier en fonction de l'environnement installé sur l'ordinateur.
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C
hapitre 1. Préparation

C
hargem

ent de la batterie/U
tilisation de base

Utilisation de base

Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

Mise sous et hors tension de l'appareil

Mise sous tension de l'appareil
Appuyez longuement sur le bouton [ ].
■ L'appareil s’allume.

Mise hors tension de l'appareil
Appuyez longuement sur le bouton [ ].
■ L'appareil s’éteint.

Lire des fichiers musicaux

1

Appuyez sur le bouton [ USER/ MENU].
■ La lecture démarre.

3
2 Appuyez sur le bouton [ + , - ] pour sélectionner

<Music> (Musique).

■   l'appareil s'éteint automatiquement lorsque aucun des boutons n'est utilisé pendant une durée
prédéfinie (par défaut : 10 secondes) en mode Pause (Pause). √ Page 42REMARQUE
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Utilisation de base (suite)

Réglage du volume

Appuyez sur le bouton [ + , - ] situé sur le côté du
lecteur.
■ La barre d'état du volume s'affiche.
■ Appuyez sur le bouton [ + ] pour augmenter le volume ou

sur le bouton [ – ] pour le diminuer.

Fonction Lock (Verrouillage)

En mode Hold, tous les boutons sont désactivés. Vous
apprécierez particulièrement le côté pratique de cette
fonction lors de vos marches ou de vos courses à pied.

1 Poussez l'interrupteur [HOLD] du lecteur dans le
sens de la flèche.

2 Poussez l'interrupteur [HOLD] dans le sens opposé
à celui indiqué par la flèche pour désactiver la
fonction Lock (Verrouillage).
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C
hapitre 1. Préparation

U
tilisation de base

Recherche de fichiers via la fonction <Navigation>

Recherchez des fichiers en toute simplicité grâce la fonction <Navigation>.

5 Utilisez le bouton [√√I] pour accéder à la liste des
fichiers dans le dossier sélectionné.
■  Utilisez le bouton [√√I] pour accédez au niveau inférieur

et sur le bouton [lœœ ] pour accéder au niveau supérieur.

4 Appuyez sur le bouton [ + , - ] pour sélectionner le
dossier de votre choix.

7 Appuyez sur le bouton [ ].
■  La lecture du fichier sélectionné démarre.

Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

1

Appuyez sur le bouton [ USER/ MENU].
■  La liste des dossiers <Navigation> s'affiche.

3

Appuyez sur le bouton [+ , - ] pour sélectionner le 
fichier de votre choix.

6

2 Appuyez sur le bouton [ + , - ] pour sélectionner
<Music> (Musique).
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Trou de réinitialisation

Utilisation de base (suite)

Fonction Reset (Réinitialisation)

Si un dysfonctionnement de l'appareil
survient, vous pouvez réinitialiser le
système en appuyant sur le trou de
réinitialisation.  √ Page 48
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Transfert de fichiers musicaux
Importation de fichiers musicaux

Transfert de fichiers musicaux
■  Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant Media Studio 

√ Page 26
■  Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant les fonctions

«Copier» et «Coller» (disque amovible) √ Page 28

Suivez les étapes ci-dessous pour transférer des fichiers.

Pour lire des fichiers musicaux, commencez par transférer les fichiers au format
MP3, WMA, Audio ASF, Ogg et autres formats compatibles depuis votre ordinateur
sur le lecteur MP3.
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Chapitre 2. Importation de fichiers musicaux
Transfert de fichiers m

usicaux/
Installation de «M

edia S
tudio»

Installation de Media Studio Utilisez Media Studio pour transférer des
fichiers musicaux de votre ordinateur vers le
lecteur.

Importation de fichiers musicaux

Avant de démarrer! Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

Si Media Studio ne s'installe pas automatiquement
■   Installez le programme sur un ordinateur fonctionnant sous Windows 2000 ou Windows XP après vous

être connecté en tant qu’administrateur. Veuillez vous reporter au manuel d’utilisation de l’ordinateur
pour savoir comment vous connecter en tant qu’administrateur.

ATTENTION

1 Cliquez sur <Install now>
(Installer maintenant).
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Installation de Media Studio (suite)
Importation de fichiers musicaux

2 Cliquez sur <NEXT> (SUIVANT).
■ L'installation de Media Studio démarre.

3 Une fois l'installation à jour terminée, cliquez
sur <Exit> (Quitter).
■ Une fois l'installation terminée, une icône apparaît

sur le bureau et Media Studio démarre.

■ Si la fenêtre de confirmation d'Autoscan apparaît,
reportez-vous à la page 25 pour personnaliser les
réglages.
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Installation de M
edia Studio/

Branchem
ent de l'appareil sur votre ordinateur

Branchement de l'appareil sur votre ordinateur
Importation de fichiers musicaux

Configuration requise

■  Pentium 300 MHz ou version ultérieure

■  Windows 98SE/ME/2000/XP

■  100 Mo d'espace libre sur le disque dur

■  Lecteur de CD-Rom (2X ou plus)

■  Port USB 2.0

■  DirectX 9.0 ou version ultérieure

Vous pouvez brancher l'appareil sur votre ordinateur si celui-ci est équipé des 
composants suivants:

1 Otez le capuchon USB situé sous le corps de l'appareil.

2 Branchez le câble USB sur le port USB (      ) de votre ordinateur.

3 Branchez l'autre extrémité du câble USB sur le fiche USB situé dans la partie
inférieure du lecteur.
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3

3

2

Ajout de fichiers / dossiers dans Media Studio
Importation de fichiers musicaux

Veuillez vous reporter à la section Aide pour obtenir plus d'informations sur 
l'utilisation de Media Studio.
■ Cliquez sur <MENU> (MENU) ➝ <Help> (Aide) ➝ <Help> (Aide) dans le menu situé en haut du 

programme Media Studio ou appuyez sur la touche F1 de votre clavier durant la lecture

REMARQUE
■   Les fichiers qui ont déjà été ajoutés à la bibliothèque ne seront plus ajoutés.
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4

4

Chapitre 2. Importation de fichiers musicaux
Ajout de fichiers / dossiers dans «M

edia Studio»

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
■ Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône Media Studio située

sur le bureau.

2 Cliquez sur l’onglet <Media Library> (Bibliothèque Media) ➝ <Library>
(Bibliothèque) situé à gauche de la fenêtre Media Studio.
■ Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>

(Balayage automatique) s'affichent.

3 Cliquez sur <Add File> (Ajouter un fichier).
■ La fenêtre Open (Ouvrir) apparaît.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).
■ Les fichiers sélectionnés sont ajoutés à la liste.

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.
■ Media Studio doit être installé sur l'ordinateur.

Pour ajouter des fichiers

3 Cliquez sur <Add Folder> (Ajouter un dossier).
■ La fenêtre Browse Folder (Parcourir les dossiers) apparaît.

4 Sélectionnez les dossiers que vous souhaitez ajouter
et cliquez sur <OK>.
■ Les dossiers sélectionnés sont ajoutés à la liste.

Pour ajouter des dossiers
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Ajout de fichiers / dossiers dans Media Studio via Autoscan
Importation de fichiers musicaux

3
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4

A
jout de fichiers / dossiers dans M

edia
S

tudio via A
utoscan

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
■ Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône Media Studio située

sur le bureau.

2 Cliquez sur l’onglet <Media Library> (Bibliothèque Media)  ➝ <Library>
(Bibliothèque) situé à gauche de la fenêtre Media Studio.
■ Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>

(Balayage automatique) s'affichent.

3 Cliquez sur <Auto Scan> (Balayage automatique).
■ La fenêtre Autoscan (Balayage automatique) apparaît.

4 Cliquez sur <OK> (OK).
■ Le balayage des fichiers s'effectue automatiquement et les

fichiers sont ajoutés à la bibliothèque.

■ Lors de votre première utilisation de Media Studio, les fenêtres
Autoscan Confirm (Confirmation d'Autosccan) et Options
(Options) apparaissent selon le cas. Réglez les options puis
cliquez sur <OK> (OK) pour lancer Autoscan.

Click <MENU> (MENU) ➝ <Tools> (Outils) ➝ <Environment
Settings> (Configuration de l'environnement) en haut de la
fenêtre Media Studio, puis cliquez sur l'onglet <Library>
(Bibliothèque).
■ Sélectionnez.la gamme et le type de fichier pour lequel vous

souhaitez effectuer un balayage automatique.

Réglage des options d'Autoscan

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.
■ Media Studio doit être installé sur l'ordinateur.

Chapitre 2. Importation de fichiers musicaux
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3

5
6

2Device Connection 
window

4

Transfert de fichiers via Media Studio
Importation de fichiers musicaux

REMARQUE

■   La technologie de reconnaissance musicale et les données relatives sont fournies par Gracenote
et Gracenote CDDBR Music Recognition ServiceSM. 

■   CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo et le
logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des marques
déposées de Gracenote. Music Recognition Service et MRS sont des marques de service de
Gracenote.
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Chapitre 2. Importation de fichiers musicaux
Tran

sfert d
e fich

iers via M
ed

ia S
tu

d
io

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
■ Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône Media Studio située

sur le bureau.

3 Cliquez sur l'onglet <Media Library> (Bibliothèque Media) situé à gauche de la
fenêtre Media Studio.

2 Double-cliquez sur le dossier de votre choix dans la fenêtre Device Connection
(Connexion de l'appareil) à droite de la fenêtre Media Studio.
■ Les fichiers contenus dans le dossier s'affichent.

4 Cliquez sur <Music> (Musique).
■ Une liste de fichiers s'affiche dans la fenêtre centrale.

■   Ne débranchez pas la câble USB durant le transfert sous peine d'endommager le lecteur ou 
l'ordinateur.

ATTENTION

■   Les fichiers ne sont pas supprimés de l'ordinateur même s'ils sont transférés vers le lecteur.
REMARQUE

5 Cochez les fichiers musicaux à transférer dans la liste de la fenêtre centrale.
■ L'icône Transmit (Transmettre) apparaît.

6 Cliquez sur <Transmit> (Transmettre).
■ Les fichiers sélectionnés sont transférés vers le lecteur.

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.
■ Media Studio doit être installé sur l'ordinateur.
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Utilisation du lecteur en tant que disque amovible

Avant de démarrer! ■ Branchez le lecteur sur l'ordinateur.

1 Ouvrez les fichiers/dossiers à transférer à
partir de l'ordinateur.

2 Cliquez sur <My Computer> (Poste de 
travail) ➝ <Removable Disk> (Disque
amovible) à partir du bureau.

3 Sélectionnez les fichiers/dossiers que
vous souhaitez transférer depuis votre
ordinateur et faites un cliquer-glisser vers
le dossier de votre choix dans
<Removable Disk> (Disque amovible).
■ Les dossiers ou fichiers sélectionnés sont 

transférés vers le lecteur.

■   Qu'est-ce que les DRM ?

La technologie et le service DRM (Gestion des droits numériques) permettent d’éviter l'utilisation illégale de
données numériques et de protéger les détenteurs de droits d'auteur. Les fichiers DRM sont des fichiers
musicaux chargés pour lesquels s'applique la technologie de protection concernant les copies illégales de
fichiers musicaux MP3 obtenus de façon légale.

Vous pouvez utiliser le lecteur comme appareil de stockage de données amovible.

■   Le message <USB Transferring> (Transfert USB) s'affiche durant le transfert. Débrancher la câble USB
tant que le message <USB Transferring> (Transfert USB) est affiché peut entraîner un dysfonctionnement
de l'appareil.

■   L'ordre dans lequel les fichiers musicaux sont affichés dans l’explorateur Windows peut être différent de
l'ordre de lecture de l'appareil.

■   Si vous transférez un fichier DRM (fichier chargé) vers le disque amovible, le fichier ne sera pas lu.

ATTENTION

■   Sélectionnez le fichier que vous souhaitez enregistrer et faites un cliquer-glisser sur l'icône du disque
amovible. Si vous changez le nom des fichiers musicaux (qui apparaissent dans l'ordre numérique,
alphabétique) dans l’explorateur Windows (ex. : 001* * * , 002* * *...), les fichiers musicaux sont lus
dans l'ordre des numéros indiqué.

REMARQUE
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1

2

Chapitre 2. Importation de fichiers musicaux
Utilisation du lecteur en tant que disque am

ovible/
Débranchez l'appareil de l'ordinateur

Débrancher l'appareil de l'ordinateur
Suivez les étapes ci-dessous pour éviter d'endommager l'appareil et les données au moment du
débranchement.

1 Positionnez le curseur de la souris sur
l'icône située sur la barre des 
tâches en bas à droite du bureau et
cliquez sur le bouton gauche de la
souris.

2 Cliquez sur le message <Safely
Remove USB Mass Storage Device
Drive> (Retirer en toute sécurité le
lecteur USB grande capacité).
■ Après avoir cliqué sur < Safely Remove

USB Mass Storage Device Drive>
(Retirer en toute sécurité le lecteur USB
grande capacité), l'appareil ne pourra pas
être rechargé même s'il est connecté à
l'ordinateur.

3 Débranchez le lecteur de l'ordinateur.

■   Ne débranchez pas le lecteur de l'ordinateur durant le transfert. Les données ou l'appareil
risqueraient d’être endommagés.

■   Vous ne pouvez pas retirer le matériel pendant que des fichiers contenus dans le lecteur sont lus
sur l'ordinateur. Veuillez réessayer une fois la lecture des fichiers terminée.

ATTENTION
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■  Avant de démarrer!
Transférez le fichier musical de votre choix depuis l'ordinateur vers le lecteur.

LECTEUR MP3
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Chapitre 3. Ecouter de la musique
E

couter de la m
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Ecouter de la musique

Ecouter de la musique

Avant de démarrer! Branchez les écouteurs sur le lecteur, mettez l'appareil sous tension et vérifiez 
l'état de la batterie.

1 Appuyez sur le bouton [ ] lorsque la lecture de
la musique est en cours. 
■  La lecture de la musique est interrompue.

2 Appuyez sur le bouton [        ] une nouvelle fois.
■  La lecture reprend à l’endroit où vous l'avez suspendue.

■   L’appareil s'éteint automatiquement lorsque aucun des 
boutons n'est actionné pendant une durée prédéfinie (par
défaut : 10 secondes) en mode Pause (Pause). √ Page 42

REMARQUE

Mode Pause (Pause)

Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

1

Appuyez sur le bouton [ USER/ MENU].
■ La lecture de musique démarre.

3
2 Appuyez sur le bouton [ + , - ] pour sélectionner

<Music> (Musique).

■   Les fichiers musicaux compatibles avec le lecteur sont aux 
formats MP3, WMA, Ogg et Audio ASF

■   Les fichiers MP1 ou MP2 possédant uniquement une 
extension modifiée vers MP3 peuvent ne pas être lus.

REMARQUE
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Ecouter de la musique

Ecouter de la musique (suite)

1 Appuyez longuement sur le bouton [ lœœ ] ou [ √√l ] pendant que la plage 
sélectionnée est en cours de lecture.
■  Ces boutons permettent d'effectuer la recherche vers le début ou la fin de la plage.

2 Relâchez le bouton dès que vous souhaitez reprendre la lecture.
■  La lecture reprend au point où vous avez relâché le bouton.

Pour effectuer une recherche à l'intérieur d'une plage

Appuyez sur le bouton [ lœœ ] après 5 secondes de lecture.
■  La plage en cours est lue à partir du début.

Lecture de la plage en cours à partir du début

Appuyez sur le bouton [ lœœ ] dans les 5 premières secondes de lecture.
■  La lecture de la plage précédente démarre.

Appuyez sur le bouton [ √√l ].
■  La lecture de la plage suivante démarre.

Lecture de la plage précédente/suivante

■   Pendant la lecture de fichiers VBR, la plage précédente peut ne pas être lue même si vous appuyez 
sur le bouton [ lœœ ] dans les 5 premières secondes de lecture. ATTENTION

■   Appuyez sur le bouton [ lœœ ] dans les 5 premières secondes de lecture pour passer à la plage 
précédente.REMARQUE
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■  <Navigation> : Vous pouvez définir l'affichage de la liste des fichiers de navigation
■  <Repeat AB> (Répéter AB) : permet de régler la répétition d’un segment.
■  <DNSe> (Egaliseur) : permet de sélectionner le mode sonore.
■  <Play Speed> (Vitesse de lecture) : permet de choisir une vitesse de lecture (rapide ou lente).
■  <Play Mode> (Mode de lecture) : permet de sélectionner le mode de répétition de la lecture

Ecouter de la musique

Fonction de personnalisation du bouton User
Pour plus de commodité, personnalisez les boutons avec les fonctions les plus souvent utilisées.

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

Pour effectuer un changement de mode simple, utilisez
le bouton [ USER/ MENU] pendant la lecture.

2 Appuyez sur le bouton [ + , - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[ USER/ MENU].
■ Le menu Settings (Réglages) apparaît.

Pour définir le mode du bouton User

3 Appuyez sur le bouton [ + , - ] pour sélectionner
<User Button Mode> (Mode du bouton User), 
puis appuyez sur le bouton [ USER/ MENU].
■ Le menu User Button Mode (Mode du bouton User) apparaît.

4 Appuyez sur le bouton [ + , - ] pour sélectionner le
mode du bouton User de votre choix, puis appuyez
sur le bouton [ USER/ MENU].

Ecouter de la m
usique/Fonction de 

personnalisation du bouton User
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Pour créer votre propre liste de lecture

2 Appuyez sur le bouton [ USER/ MENU]
lorsque la lecture de la musique est en cours.
■  La liste des fichiers figurant dans le dossier apparaît.

1 Réglez le mode du bouton User sur <Navigation>.

Vous pouvez facilement écouter votre musique préférée
en l'ajoutant à une liste de lecture.

3 Appuyez sur le bouton [ lœœ , √√l , + , - ] pour
ajouter des fichiers à la liste de lecture, puis
appuyez sur le bouton [ USER/ MENU] .
■ s'affiche devant les fichiers sélectionnés qui sont

ensuite ajoutés à la liste de lecture.

Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

■   Pour supprimer des fichiers de la liste de lecture, sélectionnez les      fichiers à supprimer, puis appuyez

à nouveau sur le bouton [ USER/ MENU].REMARQUE
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Fonction de personnalisation du 
bouton User

Pour lire une liste de lecture

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l'écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner
<Playlist> (Liste de lecture), puis appuyez sur le
bouton [ USER/ MENU].
■  La liste de lecture spécifiée s'affiche.

3 Appuyez sur le bouton [ + , - ] pour sélectionner
la liste que vous souhaitez lire, puis appuyez 
sur le bouton [ USER/ MENU].
■  La lecture des fichiers contenus dans la liste 

de lecture démarre.
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Pour rechercher la musique de votre choix à l'aide de la fonction Navigation

3 Appuyez sur le bouton [ lœœ ] pour accéder au
dossier précédent.

6 Appuyez sur le bouton [ + , - ] pour sélectionner
le fichier de votre choix.

2 Appuyez sur le bouton [ USER/ MENU]
lorsque la lecture de la musique sélectionnée est en
cours.
■  La liste des fichiers figurant dans le dossier apparaît.

7 Appuyez sur le bouton [ ] .
■  La lecture du fichier sélectionné démarre.

5 Utilisez le bouton [ √√l ] pour accéder à la liste de
fichiers dans le dossier sélectionné.
■  Utilisez le bouton [ √√l ] pour accéder au niveau inférieur

et sur le bouton [ lœœ ] pour accéder au niveau supérieur.

Appuyez sur le bouton [ + , - ] pour sélectionner le
dossier de votre choix.

4

1 Réglez le mode du bouton User sur <Navigation>.

Ecouter de la musique

Fonction de personnalisation du bouton User (suite)
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Fonction de personnalisation du 
bouton User

1 Réglez le mode du bouton User sur <Repeat AB>
(Répéter AB) et lancez la lecture du fichier de votre
choix.

Cette fonction vous permet d'écouter des parties 
spécifiques d'une plage d'une façon répétée.
Recommandée pour l'apprentissage d'une langue.

2 Appuyez sur le bouton [ USER/ MENU] au
début du segment que vous souhaitez répéter
■ Le début est défini et <A > apparaît sur l'écran d'affichage.

3 Appuyez sur le bouton [ USER/ MENU] pour
définir la fin du segment que vous souhaitez
répéter.
■ <A B>  s'affiche à l'écran et la lecture répétée de la 

section spécifiée démarre.

Pour définir la répétition d’un segment

Appuyez sur le bouton [ USER/ MENU]  pendant la répétition du segment.
■ La répétition du segment est annulée.

Pour annuler la répétition du segment

■   La répétition du segment s’annule automatiquement dans les cas suivants :
- lorsque le bouton [lœœ] ou [√√l] est actionné pour aller à la plage précédente ou suivante ;
- lorsque le début du segment à répéter est défini mais que la fin ne l’est pas avant que la plage en

cours ne se termine.

REMARQUE
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Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

Réglez le mode du bouton User sur <DNSe> (Egaliseur) et appuyez sur le bouton 
[ USER/ MENU].
■  Chaque fois que vous appuyez sur le bouton, les options du mode DNSe (Egaliseur) défilent dans

l'ordre suivant : <NORMAL> (NORMAL) <ROCK> (ROCK) <HOUSE> (HOUSE) <JAZZ> (JAZZ)
<DANCE> (DANCE) <BALLAD> (BALLADE) <R&B> (R&B) <CLASSICAL> (CLASSIQUE) 
<USER EQ> (EGALISEUR PERSONNALISE) <3D USER> (PERSONNALISE 3D) <3D STUDIO>
(STUDIO 3D) <3D STAGE> (PLATEAU 3D) <3D CLUB> (CLUB 3D).

Pour utiliser le bouton DNSe (Egaliseur)

Réglez le mode du bouton User sur <Play Speed> (Vitesse de lecture) et appuyez sur le
bouton [ USER/ MENU].
■  Chaque fois que vous appuyez sur le bouton, les options du menu Vitesse de lecture défilent dans

l'ordre suivant : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> <x1.3>.

Pour utiliser le bouton de vitesse de lecture

Réglez le mode du bouton User sur <Play Mode> (Mode de lecture) et appuyez sur le
bouton [ USER/ MENU].
■  Chaque fois que vous appuyez sur le bouton, les options du mode de lecture défilent dans

l'ordre suivant : <Normal> (Normal) <Repeat One> (Répéter une) <Repeat All> (Répéter tout)
<Shuffle All> (Lecture aléatoire de la totalité).

Pour utiliser le bouton du mode de lecture
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Réglages

Réglage de la musique Vous pouvez définir des réglages détaillés pour la 
lecture de données musicales.

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[ USER/ MENU].
■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ + , - ] pour sélectionner
<Music> (Musique), puis appuyez sur le bouton
[ USER/ MENU].
■  Le menu Music (Musique) apparaît.

4 Utilisez les boutons [ + , - ] et [ USER/ MENU]
pour définir les fonctions nécessaires.

■   Fonctions des boutons à utiliser pendant le réglage :
- Appuyez sur le bouton [lœœ] pour aller à l'élément précédent.
- Appuyez sur le bouton [√√l] pour aller à l'élément suivant.
- Appuyez sur le bouton [+, -] pour vous déplacer vers le haut ou vers le bas dans le menu actuel.
- Appuyez sur le bouton [ USER/ MENU] pour sélectionner ou enregistrer le menu.

■   Si aucun bouton n'est actionné sur l'écran Settings (Réglages) pendant environ 30 secondes, les
réglages sont annulés et reviennent à ceux définis à l'aide de la fonction précédente.

REMARQUE
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■   DNSe : vous permet de sélectionner l’effet sonore adapté au genre musical. Options disponibles : 
<3D-User> (Personnalisé-3D) <3D-Studio> (Studio-3D) <3D-Stage> (Plateau-3D) <3D-Club> (Club-3D)
<Normal> (Normal) <Rock> (Rock) <House> (House) <Jazz> (Jazz), <Dance> (Dance) <Ballad>
(Ballade) <R&B> (R&B) <Classical> (Classique) ou <User EQ (Egaliseur personnalisé).

■   Réglage 3D User (Personnalisé 3D) : permet de régler l'effet sonore 3D et le renforcement des
basses. L’effet 3D peut être réglé entre 00 et 05 et le renforcement des basses entre 00 et 03. 
Pour utiliser cette fonction, sélectionner <3D-User> (Personnalisé-3D) dans le menu <DNSe>.

■   Réglage User EQ (Egaliseur personnalisé) : permet de sélectionner directement un effet sonore
(EQ). Pour utiliser cette fonction, sélectionnez <User EQ> (Egalisateur personnalisé) dans le menu
<DNSe> (DNSe).

■   Play Mode (Mode de lecture) : permet de sélectionner le mode de lecture tel que les paramètres
de répétition. Options disponibles : <Normal> (Normal) <Repeat One> (Répéter un) <Repeat All>
(Répéter tout) <Shuffle All> (Lecture aléatoire de la totalité) et <Intro> (Intro).

■   Play Speed (Vitesse de lecture) : permet de réglez la vitesse de lecture de l'enregistrement 
musical/vocal. Options disponibles : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> ou <x1.3> 
(plus le nombre est élevé, plus la vitesse de lecture sera rapide).

■   Skip Interval (Intervalle de saut) : permet de régler l'intervalle lorsque vous appuyez sur le bouton
[ lœœ ] ou [√√l] pendant la lecture. Options disponibles : <1 Track> (1 plage) <03 Sec> (3 s) 
<05 Sec> (5 s) <07 Sec> (7 s) <10 Sec> (10 s) <30 Sec > (30 s) ou <01 Min> (1 min).

■   Search Speed (Vitesse de recherche) : permet de régler la vitesse de recherche lorsque vous
appuyez sur le bouton [ lœœ ] ou [√√l] pendant la lecture. Options disponibles : <01 Sec> (1 s)
<03 Sec> (3 s) <05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <20 Sec> (20 s) <30 Sec > (30 s)
ou <01 Min> (1 min).

■   Intro Time (Durée de l'intro) : Lorsque vous sélectionnez la fonction Intro (Intro) dans <Play Mode>
(Mode de lecture), le début de tous les fichiers est lu pendant le nombre de secondes que vous avez
définies. Options disponibles : <10 Sec> (10 s) <20 Sec> (20 s) <30 Sec > (30 s) ou <60 Sec> (60 s).

■   Pour les fichiers VBR ou Ogg, l'intervalle de saut et la vitesse de recherche peuvent ne pas être exacts.

■   Qu'est-ce que le DNSe ?
Le DNSe est un effet sonore des lecteurs MP3 développé par Samsung. Il se compose des modes 3D
(3D). Le mode 3D (3D) permet d'ajouter un effet stéréophonique à la musique.

REMARQUE
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Réglages

Réglage de l'heure Vous pouvez régler les fonctions liées au minuteur d'arrêt 
et à l'arrêt automatique.

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ USER/ MENU].
■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ + , - ] pour sélectionner <Time>
(Heure), puis appuyez sur le bouton [ USER/ MENU].
■  Le menu Time (Heure) apparaît.

4 Utilisez les boutons [ + , - ] et [ USER/ MENU]
pour définir les fonctions nécessaires.

■  <Time Set> (Réglage de l'heure actuelle) : cette fonction vous permet de régler la date et l'heure actuelles.

■  <Sleep> (Mise en veille automatique) : permet d’éteindre automatiquement l’appareil après l’écoulement de la
durée préréglée. Options disponibles : <Off> (Désactivé) <15 Min> (15 min) <30 Min> (30 min) <60 Min> (60 min) 
<90 Min> (90 min) ou <120 Min> (120 min).

■  <Auto Power Off> (Heure d'arrêt automatique) : permet d’éteindre automatiquement l’appareil lorsque aucun 
bouton n'est actionné avant l’écoulement de la durée préréglée en mode Pause (Pause). Options disponibles : <Off>
(Désactivé) <05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <30 Sec> (30 s) <01 Min> (1 min) ou <03 Min> (03 min).

Réglage de l'heure actuelle 

Appuyez sur le bouton [ lœœ ] ou [√√l ] pour atteindre
l'emplacement de votre choix, puis appuyez sur le 
bouton [ + , - ] pour régler la date et l'heure.

Une fois le réglage terminé, allez sur <OK> et
appuyez sur le bouton  [ USER/ MENU] button.

■  Le réglage de l'heure actuelle est terminé.

1

2
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■  <Scroll Speed> (Faire défiler) : permet de régler la vitesse de défilement du titre de la plage.
Options disponibles : <Slow> (Lent), <Normal> (Normal) et <Fast> (Rapide).

■  <Backlight Time> (Rétroéclairage) : permet d’arrêter automatiquement l’appareil lorsque aucun
bouton n'est actionné durant la période préréglée. Options disponibles : <05 Sec> (5 s), <15 Sec>
(15 s), <30 Sec> (30 s), <60 Sec> (60 s) ou <Always On> (Toujours activé).

■  <Contrast> (Contraste) : permet de régler la luminosité de l'écran d'affichage. Options disponibles :
valeurs comprises entre 00 et 10.

■  <Tag> (Etiquette) : permet d’afficher les informations concernant les plages des fichiers musicaux
grâce à l'étiquette ID3. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

■  <Display Time> (Durée à l’écran) : permet de contrôler la durée pendant la lecture de la musique.
Sélectionnez <Play Time> (Durée de lecture), <Remain Time> (Durée restante) ou <Total Time>
(Durée totale).

■  <Screen Saver Term> (Économiseur d'écran) : Vous pouvez régler l'affichage de l'horloge à
l'écran puis sa disparition lorsque aucun bouton n'est actionné durant la période préréglée.
Sélectionnez <Off> (Désactivé) <05 Sec> (5 s) <10 Sec> (10 s) <30 Sec> (30 s) <01 Min> (1 min) <05 Min> (5 min)
<10 Min> (10 min) ou <Always On> (Toujours activé).

Réglages

Réglage de l'affichage Vous pouvez régler les fonctions liées au défilement, 
au rétroéclairage et aux autres affichages à l'écran.

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ USER/ MENU] .
■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ + , - ] pour sélectionner
<Display> (Affichage), puis appuyez sur le bouton
[ USER/ MENU].
■  Le menu Display (Affichage) apparaît.

4 Utilisez les boutons [ + , - ] et [ USER/ MENU]
pour définir les fonctions nécessaires.
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Réglages

Réglage de la langue Permet de définir la langue du menu et des informations concernant
la plage (étiquette ID3).

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ USER/ MENU].
■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ + , - ] pour sélectionner
<Language> (Langue), puis appuyez sur le bouton
[ USER/ MENU].
■  Le menu Language (Langue) apparaît.

4 Utilisez les boutons [ + , - ] et [ USER/ MENU]
pour définir les fonctions nécessaires.

■   Les langues prises en charge peuvent être modifiées ou ajoutées.

■   Qu'est-ce que l'étiquette ID3 ?
Il s'agit d'un élément attaché à un fichier MP3 contenant les informations relatives au fichier telles que
le titre, l'artiste, l'album, l'année, le genre et un champ commentaire.

REMARQUE

■  <Menu>(Menu) : permet de régler la langue du menu. Options disponibles : <Chinese(S)>
<Chinese(T)> <Dutch> <English> <French> <German> <Hungarian> <Italian> <Japanese>,
<Korean> <Polish> <Portuguese> <Russian> <Spanish> et <Swedish>.

■  <ID3-Tag> (Etiquette ID3) : permet de régler la langue des informations concernant la plage.
Options disponibles : <Afrikaans> <Basque> <Catalan> <Chinese(S)> <Chinese(T)> <Czech>
<Danish> <Dutch> <English> <Estonian> <Finnish>  <French> <German> <Greek> <Hrvatski>
<Hungarian> <Icelandic> <Italian> <Japanese> <Korean> <Norwegian> <Polish> <Portuguese>
<Romany> <Russian> <Slovak> <Slovene> <Spanish> <Swedish> <Thai> <Turkish> et
<Vietnamese>.
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Réglages

Réglage du système Vous pouvez régler les fonctions Default Volume (Volume par
défaut), Resume (Reprise) et Beep Sound (Signal sonore).

1 Appuyez longuement sur le bouton [ USER/ MENU]
pour accéder à l’écran de menu.

2 Appuyez sur le bouton [ + , - ] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ USER/ MENU].
■  Le menu Settings (Réglages) apparaît.

3 Appuyez sur le bouton [ + , - ] pour sélectionner <System> (Système),
puis appuyez sur le bouton [ USER/ MENU].
■  Le menu System (Système) apparaît.

4 Utilisez les boutons [ + , - ] et [ USER/ MENU]
pour définir les fonctions nécessaires.

■   <Delete File> (Supprimer) : permet de rechercher et de supprimer les fichiers sur l'écran Navigation
(Navigation). √ Page 46

■   <Resume> (Reprise) : permet de spécifier le point de reprise de la lecture lorsque vous avez 
interrompu la plage musicale en cours de lecture. Si <Off> (Désactivé) est sélectionné, la lecture
reprend au début du dernier fichier écouté. Si <On (Activé)> est sélectionné, la lecture reprend à 
l’endroit où elle a été interrompue.

■   <Beep> (Signal sonore) : permet d'activer ou de désactiver l'émission d'un signal sonore lors 
du fonctionnement d'un bouton. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

■   <Default Vol> (Vol. par défaut) : le volume par défaut peut être réglé sur une valeur comprise 
entre 00 et 30 (maxi.). Si l'appareil est remis sous tension une fois que le volume a été réglé 
au-dessus de la valeur par défaut, la lecture s’effectue en fonction du volume par défaut.
Si l'appareil est remis sous tension une fois que le volume a été réglé dans la plage par défaut, 
la lecture s’effectue en fonction du volume préalablement utilisé.

■   <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut. √ Page 46
■   <About> (A propos de) : permet de contrôler les informations suivantes : la version du micrologiciel, le

nombre de fichiers enregistrés et la mémoire restante.

■  A propos de la mémoire intégrée

La taille de la mémoire intégrée réelle disponible est légèrement inférieure à celle indiquée, car le
micrologiciel interne en utilise une partie.

REMARQUE
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Réglage du système (suite)
Réglages

Appuyez sur le bouton [ + , - ] pour sélectionner <Yes> (Oui) ou
<No> (Non), puis appuyez sur le bouton [ USER/ MENU].
■  <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.

■  <No> (Non) : permet d'annuler les réglages par défaut.

Pour supprimer un fichier

Réglages par défaut

Appuyez sur le bouton [ lœœ ] pour aller au dossier
précédent.

Appuyez sur le bouton [ + , - ] pour sélectionner le
dossier de votre choix.

Utilisez le bouton [√√l] pour accéder à la liste des
fichiers du dossier sélectionné.
■  Utilisez le bouton [√√l] pour accéder au niveau inférieur et

le bouton [ lœœ ] pour accéder au niveau supérieur.

Appuyez sur le bouton [ + , - ] pour sélectionner un fichier à
supprimer, puis appuyez sur le bouton [ USER/ MENU].

Appuyez sur le bouton [ + , - ] pour sélectionner <Confirm>
(Confirmer), puis appuyez sur le bouton [ USER/ MENU].
■  Le fichier sélectionné est supprimé.

■   Les fichiers ne peuvent pas être récupérés une fois supprimés.
Soyez sûr de vouloir les supprimer avant d’effectuer l’opération.ATTENTION

1

2

3

4

5
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Appuyez sur le trou de réinitialisation situé sur la partie inférieure de l'appareil en vous
aidant d'un objet pointu (ex. : agrafe).
■  Le système est réinitialisé.

■  La fonction Reset (Réinitialisation) ne permet pas de supprimer les données enregistrées dans
la mémoire intégrée.

Trou de réinitialisation

48

Réinitialisation du système Si un dysfonctionnement de l'appareil survient,
vous pouvez réinitialiser le système en appuyant
sur le trou de réinitialisation.
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Dépannage Si un dysfonctionnement survient, vérifiez les points suivants.
Si le problème persiste, contactez le centre de dépannage Samsung le plus proche.

L'appareil ne s'allume
pas.

Les boutons ne 
fonctionnent pas.

L'écran ne s'allume pas.

L'alimentation est coupée.

Problème Points de contrôle et dépannage

■  L'appareil ne s'allume pas si la batterie est entièrement
déchargée. Rechargez la batterie et remettez l'appareil sous
tension.

■  Appuyez sur le trou de réinitialisation.

■  Vérifiez si l'interrupteur [HOLD] est dirigé dans le sens de la
flèche.

■  Vérifiez que vous avez appuyé sur le bouton adéquat, puis
essayez à nouveau.

■  Appuyez sur le trou de réinitialisation.

■  Si vous avez sélectionné <Backlight Time> (Rétroéclairage)
dans le menu <Settings> (Réglages) ➝ <Display>
(Affichage), l’écran est peut-être éteint. Appuyez sur 
n'importe quel bouton pour rallumer l'écran.

■  Il se peut que les données affichées à l’écran ne soient pas
visibles sous les rayons directs du soleil.

L'alimentation se coupe automatiquement lorsque la batterie
est entièrement déchargée. Rechargez la batterie.

La durée de vie de la 
batterie diffère de celle
spécifiée dans le manuel.

■  La durée de vie de la batterie varie en fonction du réglage des 
fonctions EQ (Egaliseur) et LCD (LCD).

■  La durée de vie de l'appareil peut être réduite si vous 
l'exposez à des températures basses ou élevées pendant
des périodes prolongées.

Réinitialisation du
systèm

e / Dépannage
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Dépannage (suite)

La lecture est 
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des don-
nées manquent.

Affichage anormal de la
durée de lecture.

Problème Points de contrôle et dépannage

■  Vérifiez que le fichier disponible a bien été enregistré dans la
mémoire.

■  Assurez-vous que le fichier musical n’est pas endommagé.
■  Vérifiez que la puissance de la batterie est suffisante.

■  Vérifiez que la câble USB est correctement branchée, puis
rebranchez-la.

■  Vérifiez que la mémoire est pleine.
■  Appuyez sur le trou de réinitialisation.

Vérifiez que la câble USB n’a pas été débranchée durant le
transfert des fichiers ou des données. Si tel est le cas, les
fichiers/données et même l’appareil risquent d’être 
endommagés. Vous devez faire preuve d'une grande prudence
car Samsung ne peut en aucun cas être tenu responsable de
la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Affichage anormal du
nom de fichier.

Allez dans <Settings> (Paramètres) ➝ <Language> (Langue) ➝
<ID3-Tag> (Etiquette ID3) dans l'écran de menu et sélectionnez la
langue appropriée.
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épannage

Dysfonctionnement du
programme.

La connexion à 
l'ordinateur est 
désactivée.

Le rétroéclairage ne 
s'allume pas.

L'appareil est chaud.

Problème Points de contrôle et dépannage

Vérifiez que la configuration requise de l’ordinateur a été 
correctement établie.

■  (Sous Windows 98SE) Vérifiez que le pilote USB est installé
et procédez à l’installation s’il ne l’est pas.

■  (Sous Windows ME/2000/XP) Cliquez sur le menu Démarrer
du bureau et lancez la mise à jour Windows. Sélectionnez
les dernières mises à jour critiques et l'ensemble des 
modifications provisoires, puis lancez la mise à jour.
Redémarrez votre ordinateur et rebranchez le lecteur.

■  Contrôlez la durée du rétroéclairage.
■  Vérifiez la batterie.

Les phases de chargement peuvent générer de la chaleur.
Cela n'a aucune incidence sur la durée de vie de l'appareil ou
sur son fonctionnement.



Chapitre 6.   Annexes

Arborescence des menus.......................53
Installation manuelle du pilote USB .....54
Spécifications du produit........................57

LECTEUR MP3



53

C
hapitre 6. A

nnexes
A

rborescence des m
enus

Ecran de sélection du menu

User EQ Set

3D User Set

DNSe

Play Mode

Search Speed

Skip Interval

Play Speed Play Mode

Intro Time

Music

Repeat AB

Navigation

DNSe

Play Speed

User Button Mode

Auto Power Off

Sleep

Time Set

Time

Contrast

Backlight Time

Scroll Speed

Tag

Screen Saver Term

Display Time

Display

ID3-Tag

Menu

Language

Beep

Resume

Delete File

Default Vol

About

Default Set

System

Music Navigation Playlist Settings

Arborescence des menus Cette fonction vous permet d’obtenir un
aperçu rapide de la structure des menus.
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1

2

3
■  Si vous utilisez Windows 2000 et que votre version de Windows ne reconnaît pas le pilote USB, veuillez

télécharger et installer la dernière version de l'ensemble des modifications provisoires à partir du site 
windowsupdate.microsoft.com

■  La méthode d'installation peut varier en fonction du type d'ordinateur ou du système d'exploitation.
Contactez votre vendeur d'ordinateur ou votre centre de services pour obtenir des informations sur
l'installation.

■  Si des erreurs se produisent de manière répétée après l'installation du pilote USB, rebranchez la câble
USB après le redémarrage de votre système.

REMARQUE

Installation manuelle du pilote USB
Installez le pilote USB manuellement lorsque l'installation automatique n'est pas possible ou
lorsqu'une erreur s'est produite lors de l'installation.

Avant de démarrer! ■ Insérez le CD d'installation dans le lecteur de CD-ROM de l’ordinateur.

Vérifiez le gestionnaire de périphériques.
Windows 98SE/ME : Panneau de 
configuration➝ Système➝ Gestionnaire
de périphériques
Windows 2000/XP : Panneau de 
configuration➝ Système➝ Matériel➝
Gestionnaire de périphériques

Vérifiez si un périphérique comportant 
un point d'exclamation ou d'interrogation 
figure dans la liste (affiché comme 
périphérique inconnu ou périphérique USB).

Double-cliquez sur le périphérique comportant un point d'exclamation
ou d'interrogation.

Si une erreur se produit lors de l'installation du pilote USB
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4 Une fois le pilote sélectionné,
cliquez sur [Reinstall Driver]
(Réinstaller le pilote).

5 Cliquez sur [NEXT] (SUIVANT).

6 Sélectionnez [Search for a suitable
driver for my device] (Rechercher un
pilote adapté à mon périphérique),
puis cliquez sur [Next] (Suivant).

7 Cliquez sur [NEXT] (SUIVANT) pour
terminer.

Next > Next >

Next >

Reinstall Driver



YP-F2

\USB Driver\win98 USB

Next >

Next > Next > Finish

Next >

56

Emplacement du pilote USB
[CD-ROM] \USB Driver\win98 USB

■  Vous pouvez l'utiliser comme disque amovible sous Windows 98SE si le programme Lecteur n'est pas
installé. Veillez à installer le fichier du pilote USB en premier.REMARQUE

Suivez les instructions qui s'affichent à l'écran pour terminer l'installation.

Vous devez redémarrer votre ordinateur pour terminer l'installation.

Sous Windows 98SE

Installation manuelle du pilote USB (suite)
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Spécifications du produit

● Le contenu de ce manuel est susceptible d'être modifié en vue d’être amélioré sans
notification préalable.

Alimentation

Nom du modèle

3,7 V (Lithium-polymère rechargeable)

YP-F2

Alimentation de la batterie intégrée

Capacité de la mémoire intégrée

280mAh

CompatibilitéFichier

Nombre de dossiers et fichiers supportés

Sortie des écouteurs

Bande de fréquences de la sortie

Taux de bruit

Durée de lecture

Plage de température pour le fonctionnement

Etui

Poids

Dimensions (L x H x P)

MPEG1/2/2.5 Couche 3 (8 kbps à 320 kbps, 8 kHz à 48 kHz)
WMA, ASF (48 kbps à 192 kbps,8 kHz à 48 kHz), Ogg (Q0 à Q9)

512MB(YP-F2 X), 1GB(YP-F2 Z), 2GB(YP-F2 Q)

20mW(France 5mW/CH)(16Ω)

Dossiers : Max. 2000 Fichiers : Max. 200

20 Hz à 20 KHz

90 dB avec filtre passe-bas de 20 KHz (sur la base de 1 KHz, 0 dB)

12 heures de lecture musicale (MP3 128 kbps, volume 20, Normal mode sonore)

-5 à 35°C

Plastique

20,5 g
28,1 x 52,5 x 15,5 mm
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Spécifications du produit

L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée à une
utilisation privée non commerciale par l’utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à un 
produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit. 
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions 
du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
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Ce symbole sur le produit ou sa documentation indique qu’il ne doit pas être
éliminé en fin de vie avec les autres déchets ménagers. L’élimination 
incontrôlée des déchets pouvant porter préjudice à l’environnement ou à la
santé humaine, veuillez le séparer des autres types de déchets et le recycler
de façon responsable. 
Vous favoriserez ainsi la réutilisation durable des ressources matérielles.
Les particuliers sont invités à contacter le distributeur leur ayant vendu le 
produit ou à se renseigner auprès de leur mairie pour savoir où et comment ils
peuvent se débarrasser de ce produit afin qu’il soit recyclé en respectant 
l’environnement.
Les entreprises sont invitées à contacter leurs fournisseurs et à consulter les 
conditions de leur contrat de vente. Ce produit ne doit pas être éliminé avec les
autres déchets commerciaux.
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Si vous avez des suggestions ou des questions concernant les produits Samsung, 
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Samsung Service Consommateurs
08 25 08 65 65 (€ 0,15/min)

www.samsung.com/fr


